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Pdf	hyperlink	to	specific	page

Select	the	text	which	you	want	to	add	a	link.	xyz.pdf#page=4	But	I	cannot	figure	out	how	can	I	point	sections	of	the	book	with	URL.	For	example,	the	following	hyperlinks	point	to	the	somewhere	of	the	book.	Users	do	not	require	to	manually	scroll	to	the	section	they	want	to	view,	so	this	feature	is	in	line	with	the	current	trend	of	fragmented	reading
and	saves	time	for	users.	A	step-by-step	guide	to	link	to	a	specific	page	in	PDF:	Step	1.	It	is	a	reliable	PDF	solution	provider	that	offers	a	large	number	of	PDF	tools,	helping	users	to	change	text	in	PDF,	annotate	PDF,	convert	PDF	to	different	formats,	add	watermark	to	PDF,	compress	files,	encrypt	and	decrypt	PDF	in	seconds.	Then	the	Add	Action
window	will	pop	up,	and	you	can	select	to	link	to	a	webpage,	a	file,	or	a	certain	page.	Link	to	a	certain	Page:	Click	Go...Page	and	set	the	number	of	the	page	you	want	to	link	to.	and	then	click	on	the	link	icon	in	the	second	menu.	Users	can	also	link	to	a	specific	part	or	page	number	in	the	PDF.	HTTPS	and	HTTP	are	the	start	of	a	URL,	looks	similar,	but
are	actually	very	different.	When	arriving	at	your	desired	page,	click	on	it.	At	the	same	time,	we	also	provide	effective	solutions.	Having	a	hard	time	linking	to	a	page	in	a	PDF?	Check	if	this	URL	can	be	opened	normally	before	creating	the	link.	Then,	choose	and	import	the	PDF	you	want	to	edit	from	your	computer.	Table	of	Contents	Links	in	a	PDF
document	allow	readers	to	jump	to	a	specific	location	outside	or	inside	the	PDF,	such	as	an	e-mail	address,	a	website	address,	or	another	document.	Generally,	one	of	the	biggest	difficulties	people	have	when	dealing	with	PDF	documents	is	trying	to	make	edits	to	them.	Step	2.	Wrap	up	These	three	methods	we	mentioned	above	can	help	you	link	to	a
specific	page	in	your	PDF	document,	and	you	can	pick	anyone	based	on	your	needs.	Or	it	enables	you	to	sign	or	compress	your	PDF	document	with	ease.	Share	this	generated	link	with	others.	Step	2.	40	2.4	The	Structure	of	Agents	.	Click	on	Tools	in	the	tool	bar.	Click	the	“Links”	button	on	the	top	toolbar.	Step	4.	With	the	cloud	services	of	Adobe,
users	are	able	to	save	and	open	files	on	any	device	without	considering	storage.	Benefits	of	Sejda:	Different	link	types	you	can	add	to	PDF	Supports	OCR	technology	Available	on	web	and	desktop	Supports	cloud	services	Free	Version	Limitations:		The	free	version	has	some	limitations,	like	uploading	files	no	bigger	than	200	pages	or	50Mb,	and	you
can	handle	3	tasks	per	hour.	Don't	fret,	this	post	is	gonna	help	you	out!	Here	you	will	learn	the	top	3	PDF	link	editors,	and	step-by-step	tutorials	to	jump	to	specific	pages	in	PDF	without	any	hassle.	59	If	you	create	a	PDF	and	want	to	ensure	the	readers	can	immediately	access	the	related	information	on	other	pages,	the	best	way	is	to	create	a	URL	to
open	a	specific	page	in	the	PDF	document.	You	can	read	the	review	before	deciding	whether	to	use	it.	Manipulate	pages:	insert,	delete,	rotate,	split,	extract	and	replace	PDF	pages.	You	can	freely	download	this	program	to	give	it	a	try.	Drag	and	drop	to	add	PDF	file	that	you	need	to	add	a	link.	Drag	and	drop	a	PDF	document	into	PDFelement,	click	the
Edit>Link	button,	then	select	the	option	of	Go	to	a	page	view,	enter	the	page	number	that	you	want	to	link	to.	Supports	native/scanned/protected	documents.	Excellent	Tools	That	You	May	Need	in	Cisdem	PDFMaster:	Edit	PDF:	add	and	replace	text,	insert	images,	add	hyperlink	to	PDF,	add	text	boxes	and	signatures	blocks.	This	program	makes	it
possible	to	hyperlink	page	in	PDF,	whether	online	or	offline.	If	you	don't	know	how	to	get	it	done,	take	a	look	at	the	following	tutorial.	Once	selected,	click	"Next"	to	set	the	page	number	and	view	the	PDF,	then	click	"Set	Link".	Move	your	cursor	to	select	the	text	or	image	where	your	link	will	be	placed.	But	first,	download	and	install	this	PDF	editing
program.	Click	on	the	three-dot	menu	next	to	the	comment	you	just	created	and	select	"Link	to	this	comment..."	This	action	will	generate	a	unique	link	for	that	specific	page	of	the	PDF.	Normally	I	create	hyperlinks	to	the	pages	like	that.	Free	Download	macOS	11	or	later	Free	Download	Windows	11/10/8/7		Earlier	than	macOS	11,	click	here	Follow
the	Steps	to	Link	to	Page	in	PDF	with	Cisdem	PDFMaster:	Run	Cisdem	PDFMaster	after	installation.	Final	Words	As	we	can	see,	linking	to	page	in	PDF	isn’t	a	hassle,	5	methods	in	this	post	are	easy	to	execute.	If	the	hyperlink	not	working	in	PDF,	you	can	use	it	to	solve	the	problem,	as	well.	This	program	allows	you	to	add	hyperlink	to	PDF	in	a	quick
way.	Launch	EaseUS	PDF	Editor	and	click	"Edit".	Upload	a	PDF	file	from	your	local	device,	or	cloud	such	as	Dropbox,	Google	Drive,	OneDrive,	or	web	address.	Here's	how	to	link	in	PDF	to	specific	page	using	Adobe	Acrobat:	Step	1.	PDFelement	will	ensure	that	all	your	PDF	editing	needs	have	been	taken	care	of,	and	you	need	not	worry	anymore
about	how	to	insert	a	PDF	page	link.	Convert	with	OCR:	convert	PDF	to	Word,	Excel,	PPT,	images,	etc.	HTTPS	is	more	secure	than	HTTP,	because	it	uses	SSL	encryption.	Choose	a	certain	part	of	your	text,	then	click	Insert	>	Bookmark.	You	need	to	give	the	new	PDF	file	a	name	and	file	location,	and	click	"Save"	in	the	next	window	to	finish.	After
setting	all	as	you	need,	click	the	Set	Link	button	to	complete.	If,	for	some	reason,	the	link	with	the	page	number	at	the	end	doesn't	work	as	expected,	you	can	use	this	workaround:	Open	the	PDF	file	in	Google	Drive	and	navigate	to	the	page	you	want	to	link	to.	Find	the	words	you	are	supposed	to	add	link,	then	right-click	it.	For	those	people	who	want
to	find	an	all-in-one	PDF	editing	program,	we	recommend	EaseUS	PDF	Editor	as	the	first	choice.	Adobe	Acrobat	Pro	DC	Benefits:		Enable	to	change	the	link	appearance		Cloud	services	support	Rich	features	like	OCR	and	collaborative	tools	Supports	multi-languages	Excellent	and	versatile	editing	tools	Pricing:	Yearly	Subscription:	$239.88	Monthly
Subscription:	$29.99	#2	Create	Interactive	Links	with	Adobe	InDesign:	Open	a	PDF	with	Adobe	InDesign.	Here's	how:	Simply	use	the	following	format	for	your	Google	Drive	link:	number]	Replace	"[ID]"	with	the	document's	unique	ID	on	Google	Drive,	and	"[page	number]"	with	the	specific	page	you	want	to	jump	to.	Adobe	Acrobat	Import	the	PDF	file
into	Adobe	Acrobat,	and	click	on	"Tools"...Full	steps	Fix	3.	Step	5.	Some	PDF	readers	or	devices	do	not	support	interactive	PDF,	you	need	to	rely	on	almighty	PDF	editors	in	this	way.	Step	4.	Click	on	the	"EDIT"	button	in	the	top	toolbar.	Apart	from	that,	this	PDF	tool	allows	adding,	replacing,	and	removing	text	from	PDF	in	no	time,	and	it	also	enables
you	to	convert	and	manage	your	PDF	effortlessly	like	below:	Free	DownloadWindows	11/10/8/7	Speaking	of	hyperlink	to	a	specific	PDF	page,	you	can	check	the	below	tutorial.	Both	Adobe	Acrobat	Pro	and	Adobe	InDesign	can	create	link	to	page	in	PDF,	pick	the	one	that	want	to	download	or	have	installed	on	PC.	Drag	the	cursor	to	mark	up	the	text
you	need	to	create	a	link.	59	Rearrange	PDF	pages	Convert	PDF	to	JPG	Create	PDF	online	Convert	Word	to	PDF	online	Convert	Excel	to	PDF	online	Convert	PowerPoint	to	PDF	online	Convert	JPG	to	PDF	online	Compress	PDF	online	Sign	Microsoft	Word	documents	Create	electronic	signatures	Create	digital	signatures	Create	PDFs	Edit	PDFs	Export
PDFs	Combine	Files	Review	and	Comment	Scan	and	Optimize	Mobile	PDF	Protect	PDFs	PDF	Forms	Sign	and	Send	PDFs	Print	Production	PDF	Standards	Accessibility	JavaScript	I	am	trying	to	create	a	pointer	link	to	a	specific	section	of	the	PDF	file	which	is	in	my	local	directory.	Hyperlink	to	a	Specific	Page	in	a	PDF	with	Soda	PDF	Apart	from	Adobe
Acrobat,	Soda	PDF	also	has	a	good	reputation	on	the	market.	Users	may	need	to	insert	links	to	a	specific	page	in	the	following	scenarios.	Then	in	the	pop-up	dialogue,	enter	the	URL	and	apply	it.	Import	the	PDF	file	into	Adobe	Acrobat.	When	a	new	window	appears,	you	can	change	the	link	appearance.	And	it	lacks	some	regular	conversion	formats,
such	as	PDF	to	EPUB.	Select	the	text	that	you	want	to	link	to	with	cursor,	head	to	Windows	>	Interactive	>	Hyperlinks.	Method	2.	EaseUS	PDF	Editor		Click	"File"	>	"Open"	to	import	the	PDF	file...Full	steps	Fix	2.	Add	Link	to	PDF	Page	Once	the	file	is	open,	go	to	the	"Edit"	tab	to	select	the	text,	edit	text,	edit	an	object,	or	add	a	link.	As	for	linking	to	a
PDF	page,	it	is	just	a	piece	of	cake.	Then	a	Create	Link	dialog	box	will	appear,	and	you	will	see	three	options:	Go	To	A	Page	View,	Open	A	File,	and	Open	A	Web	Page.	The	package	is	lightweight	and	does	not	take	up	much	storage,	so	everyone	is	welcome	to	download	and	experience.	Soda	PDF	Download	and	install	Soda	PDF	on	your	computer,	then
open	your	desired	PDF...Full	steps	Method	1.	Open	PDF	link	to	specific	page	When	you	open	a	PDF	file	in	a	browser,	it	typically	displays	the	first	page	automatically.	Alternatively,	you	can	find	the	file	on	your	computer,	right-click,	and	select	"Open	with	>	Wondershare	PDFelement."	Step	2.	4	Situations	Here	If	you	have	tried	the	above	methods	but
still	cannot	successfully	jump	to	the	specified	part,	see	if	you	can	find	the	reason	why	your	link	is	not	working	in	this	section.	If	you	enter	a	wrong	URL	or	the	URL	has	been	changed,	of	course,	you	can’t	jump	to	the	normal	web	page.	Sign	PDF:	electronically/digitally	sign	PDF	with	highly	secured	digital	ID.	Also,	workable	links	rely	on	Internet
connection,	so	make	sure	the	system	is	connected	to	the	server.	At	last,	do	not	forget	to	save	your	edited	PDF	file	to	your	computer.	Here	we	recommend	Sejda.	Link	to	specific	page	of	a	PDF	on	local	drive	If	you	have	a	PDF	saved	locally	on	your	computer	and	you	want	to	link	to	a	specific	page	within	it,	you	can	follow	these	steps:	Step	1:	Navigate	to
the	PDF	file	saved	on	your	local	drive.	In	the	top	toolbar,	click	on	"Tools"	>	"Edit	PDF"	>	"Link"	>	"Add	or	Edit"	button	in	turn.	Other	than	the	online	version,	it	is	also	compatible	with	Windows,	macOS	and	Linux.	Download	and	install	Soda	PDF	on	your	computer,	then	open	your	desired	PDF	document	with	it.	In	this	article,	you	can	receive	5	smart
and	easy	methods	to	link	to	page	in	PDF	in	seconds.	Here	are	some	benefits	and	limitations	of	the	free	version.	Right-click	on	the	file	and	select	"Open	with"	and	then	choose	your	preferred	web	browser.	Most	of	the	link	tools	not	only	have	the	function	of	jumping	to	the	page,	but	also	provide	more	options.	When	you	enter	this	modified	PDF	link	into
your	browser,	it	will	directly	open	the	PDF	file	at	the	specified	page,	making	it	more	convenient	for	users	to	access	the	desired	content.	Then	a	small	bookmark	will	appear	beside	the	text.	You	may	choose	to	add	text,	image,	link,	watermark,	set	background,	edit	header	&	Footer,	etc.	You	will	see	a	confirmation	in	the	"Add	Action"	window	and	click
"ADD".	Then	choose	“Go	to	a	page	view”	and	click	“Next”.	A	dialog	box	will	appear,	which	lets	you	set	the	link	appearance	and	link	action.	PDF	Link	to	Page	Using	Adobe	Acrobat	As	the	most	popular	PDF	link	editor,	Adobe	Acrobat	can	meet	almost	all	your	needs	for	PDF	editing.	Scroll	through	your	PDF	to	find	the	area	you	want	to	create	a	hyperlink,
then	drag	a	rectangle	to	select	it.	Edit	Your	PDF	(Optional)	In	addition	to	adding	links	to	your	PDF	document,	you	can	also	click	the	"Edit"	button	under	the	"Edit"	tab	to	modify	the	texts	and	images	in	your	document.	Then	you	can	jump	to	the	specific	page	number	by	clicking	the	text.	Scroll	to	the	page	you	want	to	link	to,	and	click	“Set	Link”.
However,	if	you	need	to	share	a	PDF	link	that	directly	opens	to	a	specific	page,	you	can	achieve	this	easily	by	adding	a	specific	string	to	the	PDF	link.	Also,	you	can	adjust	the	border	style	and	color	of	the	hyperlink	area.	How	to	Add	Link	to	Page	in	PDF	Wondershare	PDFelement	-	PDF	Editor	Wondershare	PDFelement	Wondershare	PDFelement	is	a
tool	that	is	simple	to	operate,	yet	has	many	functions	for	you	to	choose	from.	#1	Link	to	Page	in	PDF	with	Adobe	Acrobat	Pro	DC	Easily:		Go	to	Tools	>	Edit	PDF.	There	are	many	editing	tools.	For	set	a	hyperlink	to	a	certain	page	in	PDF,	you	can	get	help	from	the	below	tutorial.	Open	PDF	in	the	Program	Launch	PDFelement	on	your	computer	and
then	click	on	"Open	File."	Browse	through	the	files	and	select	the	one	you	want	to	add	a	link	to.	For	instance,	some	writers	will	add	links	to	subheadings	or	proper	nouns,	making	it	easier	for	readers	to	jump	to	the	appropriate	page	for	a	quick	read.	Free	DownloadWindows	11/10/8/7	I	am	trying	to	create	a	pointer	link	to	a	specific	section	of	the	PDF
file	which	is	in	my	local	directory.	Step	3:	Press	the	Enter	key	to	load	the	PDF	file,	now	directly	at	the	specified	page.	The	multi-lingual	OCR	functionality	recognizes	over	25	languages	and	makes	scanned	PDF	searchable	and	editable.	Link	to	hyperlink:	Click	on	Hyperlink	and	insert	the	link	you'd	like	then	click	Go.	Link	to	Email:	If	you	need	to	set	to
link	and	send	email	you	can	click	on	Email,	then	type	the	email	address	and	click	Go.	Link	to	Specific	Page	in	PDF	with	Google	Drive	Google	Drive	is	a	cloud-based	program	that	enables	users	to	store	and	open	files	anywhere.	How	to	Create	Link	to	A	Specific	Page	in	PDF?	Upload	your	PDF	file.	Next,	select	the	"Link"	option	to	add	hyperlinks	to	your
PDF	file.	Step	5.	Click	“Apply	changes”	to	save	your	PDF	files.	Adobe	InDesign	Benefits:		Make	interactive	hyperlinks,	bookmarks,	buttons	and	forms	Cloud	documents	Export	projects	as	PDF,	images,	XML,	MP3	and	more	Pricing:	Yearly	Subscription:	$239.88	Monthly	Subscription:	$31.49	Why	My	Links	Still	Not	Working	in	PDF?	.	Well,	we	are	here	to
tell	you	about	a	tool	that	will	make	all	your	woes	go	away.	Let’s	look	down	together.	Hyperlink	to	a	Specific	Page	in	PDF	with	EaseUS	PDF	Editor	The	first	PDF	link	editor	we	are	going	to	share	is	EaseUS	PDF	Editor,	which	offers	lots	of	PDF	editing	tools,	including	hyperlink	to	a	specific	page	in	PDF.	If	you	are	wondering	how	to	add	a	hyperlink	to	a
specific	page	in	a	PDF	or	how	to	create	a	link	to	open	a	specific	PDF	page,	this	article	will	give	you	a	perfect	answer	to	each	question.	Choose	an	area	where	you	want	to	create	a	link	and	drag	your	cursor	around	the	text.	Choose	“Link	to	internal	page”	and	enter	the	page	number	you	want	to	access.	Create	Link	to	Page	in	PDF	with	Adobe	Countless
businesses	rely	on	Adobe	software	to	process	PDFs	and	share	PDF	documents	with	teammates.	Free	Download	or	Buy	PDFelement	right	now!	Free	Download	or	Buy	PDFelement	right	now!	Try	for	Free	right	now!	Try	for	Free	right	now!	I	am	trying	to	create	a	pointer	link	to	a	specific	section	of	the	PDF	file	which	is	in	my	local	directory.	Scroll
through	the	PDF	document	with	your	mouse	wheel.	We	believe	that	you	can	feel	the	intention	and	discover	the	benefits	in	the	free	trial.	Link	to	specific	page	of	a	PDF	on	Google	Drive	If	your	PDF	files	are	stored	on	Google	Drive,	you	can	easily	link	to	a	specific	page	within	the	document	by	adding	the	page	number	to	the	end	of	the	Google	Drive	link.
Why	Need	to	Link	to	a	Specific	Part	of	a	Page?	Always	remember	to	save	the	changes	with	the	"Save"	button.	To	open	a	PDF	on	a	particular	page,	simply	add	"#page=[page	number]"	to	the	end	of	the	link	URL.	With	its	help,	you	are	able	to	create	a	link	in	PDF	to	open	a	specific	page,	a	named	position,	or	a	webpage	flexibly.	34	2.2	Good	Behavior:	The
Concept	of	Rationality	.	When	you	made	all	the	changes,	click	"File"	>	"Save	as"	to	save	it	to	your	computer.	When	they	open	the	PDF	using	this	link,	it	will	automatically	direct	them	to	the	intended	page.	If	you	wish	you	make	changes	on	your	PDF	pages,	you	can	go	to	the	"Page"	menu	and	insert	new	pages,	delete	unwanted	pages,	rotate	pages	to	a
certain	degree,	crop	pages	to	adjust	aspect	ratio,	etc.,	and	more.	Workable	Solutions	Step-by-step	Troubleshooting	Fix	1.	Choose	“Headings	and	bookmarks”	from	the	drop-down	menu,	and	select	the	bookmark	you	added	before.	Compress	PDF:	make	PDF	smaller	with	high	compression,	medium	compression	and	low	compression.	So	you	need	to	know
the	complete	domain.	I	want	to	know	what	is	the	URL	syntax	for	accessing	these	sections.	Step	1.	Whether	you	want	to	view,	create,	edit,	convert,	or	manage	your	PDFs,	this	Windows	PDF	editor	can	make	them	easy.	PDFelement	is	capable	of	meeting	all	your	PDF	editing	needs.	Tick	the	"Go	to	a	Page	View"	option	and	specify	the	page	you	want	to
link.	Here	is	How	to	Link	to	a	Specific	Page	in	PDF	with	Google	Docs:	Go	to	Google	Drive	and	open	a	PDF	file	with	Google	Docs.	Select	the	text	you	wish	to	make	into	a	link.	Encrypt	and	Decrypt	PDF:	add	password	or	remove	forgotten	password	with	a	click.	In	Google	Drive,	we	can	open	PDF	files	and	set	a	link	to	a	specific	page	with	Google	Docs.	2
Intelligent	Agents	34	2.1	Agents	and	Environments	.	The	Easiest	and	Fastest	Way	to	Link	to	Page	in	PDF	The	first	link	tool	we’d	like	to	introduce	is	Cisdem	PDFMaster,	which	is	the	easiest	and	fastest	way	to	link	to	page	in	PDF.	From	functions,	cost,	security,	user	groups	and	other	aspects	of	analysis,	Cisdem	PDFMaster	is	definitely	one	of	the	most
comprehensive	PDF	products	for	Mac	users	and	Windows	users.	For	linking	to	a	specific	page	in	your	PDF,	you	should	choose	the	first	option	–	"Go	To	A	Page	View".	Following	these	steps	will	allow	you	to	easily	share	a	link	to	a	specific	page	within	a	locally	stored	PDF	file.	With	its	help,	you	can	change	any	element	within	the	PDF	file,	such	as	add
image	to	PDF,	change	the	orientation	of	PDFs,	and	so	on.	Is	Sejda	really	worth	trying?	36	2.3	The	Nature	of	Environments	.	Preview	your	PDF	file,	and	you	can	export	and	save	it	when	you	are	satisfied	with	it.	Follow	the	steps	below	to	learn	about	how	to	link	to	page	in	PDF	with	Sejda	online.	Use	your	mouse	to	download	the	free	version	and	link	to
page	in	PDF	effortlessly.	46	2.5	Summary,	Bibliographical	and	Historical	Notes,	Exercises	.	Click	the	“Link”	button	and	choose	“Add/Edit	Web	or	Document	Link”	from	the	drop-down	menu.	59	Then	the	text	is	interactive	with	a	hyperlink.	You	can	also	hyperlink	your	PDF	to	a	specific	webpage.	Create	a	comment	on	that	page.	Linking	to	a	specific	part
of	a	page	in	PDF	helps	readers	fast	access	and	find	the	resources	they	want	to	read,	especially	in	a	long	document.	On	the	right	side	of	the	interface	you	can	set	to	link	to	a	pages,	or	add	a	hyperlink	or	link	to	email.	Here	we	choose	the	"Go	to	Page"	button.	This	website	provides	a	wonderful	link	tool	that	works	easily	and	quickly	to	link	to	page	in	PDF.
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